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Dear customer,

Thank you for choosing aANr¢uRIC products.

Maybe you are familiar with 3D printing technology or have purchased
ANYCURIC printers before, we still highly recommend that you read this
manual carefully. The installation techniques and precautions in this
manual can help you avoid any unnecessary damage or frustration.

More information please refer to :

1. http://www.anycubic.com/

ANYCURIC website provides software, videos, models, after-sale service,
etc.

Please go to our website to report any issues and we are likely to answer
or solve all the questions for you!

2. Facebook page and Youtube channel as shown below.

ANYCURBIC website Facebook page Youtube channel

Team ANYCURIC

Copyrighted by “Shenzhen Anycubic Technology Co., Ltd “, all rights reserved.


http://www.anycubic.com/

Safety instruction

Always follow the safety instructions during assembly and usage, to

avoid any unnecessary damage to the machine or individual injury

Please contact our customer service first if you have any issue
after receiving the products.

Be cautious when using the scraper. Never direct the scraper
towards your hand.

In case of emergency, please immediately cut off the power of
ANYCURIC 3D printer and contact the technical support.

ANYCURIC 3D printer includes moving parts that can cause injury.

It is recommended to wear protection glasses when printed
models to avoid small particles contacting eyes.

Keep the anvcuei¢ 3D printer and its accessories out of the reach
of children.

Vapors or fumes may be irritating at operating temperature.
Always use the aNvcuelic 3D printer in an open and well
ventilated area.

ANYCURIC 3D printer must not be exposed to water or rain.

ANYCURIC 3D printer is designed to be used within ambient
temperature ranging 8°C-40°C, and humidity ranging 20%-50%.
Working outside those limits may result in low quality printing.

Do not disassemble aANrcuelc 3D printer, please contact
technical supportif you have any question.

FECe g & H
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Technical Specification

Printing

Technology: FDM (Fused Deposition Modeling)

Build Size: 300X 300X 305 (mm3)

Print accuracy: 0.05-0.3 mm

Positioning Accuracy: X/Y 0.0125mm, Z 0.002mm

Extruder Quantity: Single

Nozzle Diameter: 0.4 mm

Print Speed: 20~100mm/s (suggested 60mm/s)

Travel Speed: 100mm/s

Supported Materials: PLA, ABS, HIPS, Wood, etc

Temperature

Ambient Operating Temperature: 8°C - 40°C

Operational Extruder Temperature: max 250°C

Operational Print Bed Temperature: max 90°C

Software

Slicer Software: Cura

Software Input Formats: .STL, .0BJ, .DAE, .AMF

Software Output Formats: GCode

Connectivity: Memory card; Data cable(expert
users only)

Electrical

Input rating: 110V/220V AC, 50/60Hz

Physical Dimensions

Printer Dimensions: 500mmx500mmx553mm

Net Weight: ~14kg



Packing list

TG

1111l
il1illl

A

M5*8 screw 10PCS

Plier 1PCS

i\

Mega X

Filament holder TPCS
M3*5 screw 2PCS

Gift Filament
1PCS

ﬁ_ —_———

EI

—
B

9y

Assembly instruction
1PCS

After sale service card
T1PCS

Filament sensor
1PCS

=

W

Power cord 1PCS

Data cable 1PCS

Gloves 2PCS

Memory card 1 PCS

Card reader 1PCS

Tool kit 1 unit

N\

/|

=

Extra print head 1PCS

Tweezers& Nozzle cleaning
needle

1 PCS each

Scraper

1PCS

2



Product Overview

ANTCURIC

Front view

X limit switch : Air duct

Adjustable nut

Display screen

Back view

Teflon Feeding
tube

Extruder

Print platform

Filament sensor
Y limit switch

Frame

Filament holder

Base

X motor

Z limit switch

Z motor



Menu Directory

Home menu

MLSUME

Previous page Next page



Menu Directory

Home menu

Nozzle Temp /Target Temp s Heated bed Temp/Target Temp

Enter the print list Enter the tools list

Enter the setup list

Printer status

Print

Return to the home menu =

Page up
o Page down
File list
Print the selected files P (R Al Refresh the list

in memory card
Resume form outage (only valid

for offline print via memory card)

Setup
Language: Change language (English/Chinese)

Temperature:

Reduce nozzle Temp Raise nozzle Temp

Click to set nozzle
Temp(170-260°C)

Click to set heated bed
Temp(0-100°C)

Current nozzle Temp

Current heated bed Temp

Reduce heated bed Temp | | Raise heated bed Temp




Menu Directory

Motor: Disable all motors (only valid when machine is not printing)

Speed:

Decrease fan speed Increase fan speed

Current fan speed Click to set fan speed(0-100%)

Current print rate Click to set print rate(50-100%)

Decrease print rate| | Increase print rate

Status: (the following with * is valid only for offline printing , i.e. print

from memory card)

Return to previous menu [
Files*
Time
Nozzle Temp/Target Temp
Coordinates for X/Y/Z axis

Pause print*

Print Rate
Progress*
Heated bed Temp/Target Temp

Stop print*

Voice: Turn on/off the screen sound

Tools

Home: (only valid when machine is not printing)

Return to previous menu s

Click to home X kit Rt Click to homeY

Clickto home z e Hatne Al Click to home All




Menu Directory

AXis: (only valid when machine is not printing)

Move left/right X axis by 0.1/1.0/10mm

Move backward/forward Y axis by 0.1/1.0/10mm
Move down/up Z axis by 0.1/1.0/10mm

Return

Nozzle Temp/Target Temp Heated bed Temp/Target Temp

Click to preheat PLA Click to preheat ABS

Return

Cooling: Cut off the power to hot-end and heated bed (only valid when
machine is not printing)

Reset: Popup window to decide if reboot the mainboard

Filament: (only valid for offline print)

Automatically heating to
the setting temperature
for filamentin

Automatically heating to
the setting temperature
for filament remove

Stop to filament in/remove Return

Help: Basic description of the Menu

About: Information about the product



Installation

1. Installation section contains: @lInstall the frame @Wwiring
2. Be cautions during assembly as some parts may have sharp edges.
3. Itis suggested to use a flat desktop and place the parts in an

orderly manner for quick assembly.
4. The color of some parts may be different from what in the manual,
but the assembly is the same.

5. Firmware has been pre-uploaded to the motherboard. After
completing the assembly, please level the platform and load the
filament then you could start the first test print.

6. The print head must be covered with an insulated sleeve to

maintain a constant temperature of the print head. Don’t remove it.

Please note: every units of the printer have been inspected and tested
for printing. Therefore, in some cases, there might be very small marks
left on the print head or on the heated bed. Those will not affect the
printing quality and those means the printer has been tested for the
quality. Meanwhile, we provide an extra hot end in case you need to
replace it in the future. Thank you very much for your kind

understanding.

Team ANTCURIC



Installation

Pre-installation check: D-shape wheels of the base may be loosened
due to transportation, please check it after unpacking.

Place the base on a flat desktop. Keep the heated bed stationary by
hand, then turn the D-shape wheels, and if the wheels are idling, adjust

them as follows.

D-shape wheel Hexagonal pillar

Adjustment method: Use a wrench to tighten the hexagonal pillars
clockwise in the order of 1—2—3—4, as shown in the figure above. Then
push the heated bed to observe until they can smoothly rotate with the

movement of the heated bed. @ Tighten the hexagonal

pillar clockwise with a 10mm

opening wrench.

@ Fix the nut with a 8mm
opening wrench.



Installation

1. Install frame
(1) Take off the screw on one side of the fixture, and then fix the fixture

to the frame with the screw, as shown below. Check the screws on both

sides of the fixture to make sure the screws are tightened.

Frame

Take off the
screw

Fixture

(2) Carefully lift the base to fit into the frame and fix them by 8 pieces of

M5*8 screws as shown below. Fasten the screws when all the screws

are pre-installed.

ANTCUBIC




Installation

(3) Take off two screws of the frame and then install the holder of the

filament sensor to the frame with the two screws.

v

e off those
two screws

ANTCURBIC

=

S Adjust the direction of filament sensor
to allow filament feeding smoothly,
and then tighten the screw.

M

Pay attention to the direction of the

holder 11




Installation

(4) Use two M3*5 screws to install the filament holder, then loosen the
two screws on the lower right side of the frame, until the filament

holder could be installed, and then tighten those two screws.

ANYCURIC

/" Loosen those two screws until
the holder could be installed
and tighten them again.

2. Wiring
(1) Select the correct voltage mode according to your local voltage
ratings (110V/220V). The switch is inside the bottom left of the base

and 220V is default. Allan keys can be used to move the switch inside.

ANTCUBIC

@) l2zov |B 110y o S

In some cases, 220V labeled as
"230", 110V labeled as “115"

12



Installation

(2) There are 3 ports with different color (Red/Green/Black) at the
bottom right side of the base, and there are 3 different color cable
connectors respectively. Accordingly, insert those connectors to the
ports by the same color. Then insert the filament sensor wire to the
corresponding port of the filament sensor.

'.
i
> Make sure the connectors are well i
|

inserted, and no pins are bent inside. i
\

> Wrong or loose connection would \

lead to malfunction of the machine.

(3) Customers may notice there is a ring of zip tie attached just below
the plastic ring of the quick connector. Do not cut it off. Only cut this zip
tie when swapping or repairing the hotend.

AMTLLIEC

Zip tie Plastic ring

13



Leveling

It is essential to level the print platform of a 3D printer. Once
leveled, it is not necessary to level every time before each prints.
Please follow the procedures below:

1. Manual Leveling

Step 1. Plug in the power cord and power on the printer.

Step 2. On the “Home Menu”, click “Tools"-->"Home"-->"Home Z". Lock

the Z axis to prevent the Z axis from falling during leveling.

Home-Y'

Home &l

Step 3. Place the leveling paper (included on top of the printing
platform) on the lower left corner of the printing platform, as shown

below.

Leveling paper

14



Leveling

Step 4. Manually move the printing head and platform to the point @.
Tighten or loosen the adjustable nut underneath the printing platform
to adjust the distance between the nozzle and the platform to about
the thickness of the paper(~0.1-0.2mm, the nozzle just touches the
paper), as shown below. You need to adjust the adjustable nut until
you feel the drag resistance when pulling the paper back and forth.
(Note: “feel the drag resistance” means the paper can be moved, but

with resistance)

Note: Do not press on the platform when adjusting the nut,
otherwise it will be affecting the leveling accuracy.

15



Leveling

Step 5. Follow step 4 to level the other three corners (2—®—®), as
shown below. You need to adjust the 4 points of the platform 2 or
3 times to ensure leveling result is OK, otherwise the platform
could be scratched.

Step 6. Move the printing head and platform at the same time, so that
the printing head can be moved in diagonal order, as shown below. In
the process of moving, check whether the distance between nozzle and
printing platform is about a piece of paper thin or not. You may need to
adjust the 4 points of the platform 1 or 2 times to check the leveling
result.

Note: Do not let the nozzle rub against the printing platform
directly during the whole leveling process. When moving the nozzle,
paper must be placed on the platform to prevent the platform from
being scratched by the nozzle.

Tips: The printing platform has the characteristics of high temperature
resistance, long service life, good adhesion and easy removal of prints.
Its flatness is in the range of 0~0.2mm variation, means every piece of
the platforms has been tested by a 0.2mm feeler gauge on a flat

marble table.
16



Leveling

2. Supplements to leveling

In some rare cases, after “Home All”, the nozzle can be still much lower
than the platform, even after fully tighten the 4 nuts underneath. On
the opposite, sometimes the nozzle is still too high from the platform,
even after fully loosen the 4 nuts underneath.

How to solve this: adjust Z adjustable nut. At both ends of X axis, there
is a Z adjustable nut. The lower tip of Z adjustable nut can trigger the Z
end stop when Home (going down), and ‘tell’ the machine Z axis is

getting to zero and stop moving.

(1) Raise the nozzle by click "Tools”-->"Axis"-->"10"on +Z column,
adjust the 4 nuts under the platform, let the height in-between the

support plate and the heated bed is ~15mm for all the 4 corners.

17



Leveling

ANTCURIC

(2) Tighten Z adjustable nut by Xmm if nozzle is lower than the
platform (Xis defined by how much the nozzle is under the platform),
while loosen it by Ymm if nozzle is too high from the platform (Yis
defined by how much the nozzle is above the platform). It may need

adjustment for few times.

WOVIRES '|'|.I|'p'i,l|'|.!|'4.'|.'|'|;i'i'|.

Tighten or loosen it

Z adjustable nut

(3) Click “Tools”"-->"Home"-->"Home all” to verify the results. After this,

please level the platform again as described above.
18



Printing test

1. Filamentin
(1) Step 1. Return to the home menu, click “Tools"—"Axis"—"10+Z" 10
times to rise the print head.

i
N 54103
L

ﬁ'* ' 10 1 140

; el vl valn P
B 014 )
== LI M M |u‘

(2) Place the filament on filament holder, please note the direction of
filament.Click “Tools”"— “Filament”"— “Filament in”, and the interface as
shown in the figure below will pop up, click “OK". Straighten the end of
filament, pass the filament through filament sensor, and then press the
handle on the extruder and push the filament in until it just goes in the
white Teflon tubing.

Cold extrusion prevented
puta heating on

W

Filament sensor

19



Printing test

(3) When the nozzle reaches to the target temperature (i.e. 230°C), click
“Filament in” again, the filament would be automatically fed in by the
extruder and it would be melted through the nozzle. Now, click “STOP".
You may use tweezers to clean the filament residue on the nozzle tip.

Filaman |

Rt |

Note: During feeding, if the melted filament is not smooth or too thin,

please adjust the extrusion force by rotating the knob as shown below.

If the melted filament is not If the melted filament is too
smooth, please increase the thin, please reduce the
extrusion force by rotating extrusion force by rotating
counterclockwise clockwise

20



Printing test

2. Print test
Insert the memory card into the memory card slot at the base. Click on
the Home Menu “Print” to enter the file list. There is a printable test file

included -- "owl_pair” (author: etotheipi, www.thingiverse.com).

Single click on “owl_pair”, and click “Print”. The machine will be

automatically heating the platform and nozzle before printing.

PRIET RESUME

There might be 3 kinds of results for the first layer of the test prints.
A: Nozzle too close, lack of extrusion, the nozzle rub against the
platform. Slowly tighten the corresponding nuts underneath by half
circle or level again.

Nozzle too close

Filament

‘

Proper nozzle height

Filament
|

21


http://www.thingiverse.com/

Printing test

C: Nozzle too high, Large gap, filaments are not even adhere to the
platform. Slowly loosen the corresponding nuts underneath the
platform by half circle or level again.

Nozzle too high

If you can't improve the model printing effect by fine-tuning the
adjustable nut in the printing, please click “STOP” on the screen, return
to the Home Menu, and click “Tools” — “Axis” to raise the Z axis by
10mm. Then use a spatula to shovel the model and level the platform

again as described above.

22



Driver installation

There are two operational mode for Mega X : print offline and print online.
Print offline: As shown previously, after insert memory card, platform
leveled, click “Print” on the display and print a selected file (GCode files
ONLY).

Print online: Install CP2102 driver to bridging PC and machine, and install

Cura for slicing and control the machine to print via data cable.

Print offline Insert memory card

Mega X

Install driver

Print online PC control via data cable

Install Cura

It is suggested to use Print Offline mode to minimize the noisy signal
via data cable.

How to install the software to enable PC control (print online).

First, turn on the machine, connect the printer (data cable port) and
your PC via data cable. Mega X uses CP2102 chip for communication.
The CP2102 driver may not be installed automatically, so it is required
to check that. Right click “This PC"— “Properties”"—"Device manager”, if
there is an exclamation mark as shown below, then it needs to be

installed manually.

& Device Manager
File Action View Help
= B HE 2

~ @ DESKTOP-GP585L4

i Audic inputs and outputs
[ Computer
- Disk drives
L& Display adapters
i Human Interface Devices
=@ |DE ATA/ATAPI controllers
= Keyboards
w Mice and other pointing devices
[ Menitors
[ Metwork adapters
~ B Other devices
|B& CP2102 USB to UART Bridge Controller |
& Ports (COM & LPT)
@ EERD com

<

23



Driver installation

CP2102 driver files are located in the memory card (or visit our website
to download). “Files_English_ MEGA X"—"Driver_CP2102"—"Windows"
(“CP210xVCPInstaller_x64" is for 64 bit system and
“CP210xVCPInstaller_x86" is for 32 bit system). Here Windows 7 64 bit

PCis taken for example:

~ 8 DESKTOP-GP385L4

i Audic inputs and outputs @ How do you want to search for driver software? @
I Computer

s Disk drives

[ Display adapters

i Human Interface Devices —> Search automatically for updated driver software

@ IDE ATA/ATAP! controllers Windows will search your computer and the Internet for the latest driver software

Keyboards 1 1 for your device, unless you've disabled this feature in your device installation
(@ Mice and other pointing devices ng ht Clle U pd ate o ' : )

settings.
= Menitors g

I Network adapters
v |7 Other devices

L G N B — Browse my computer for driver software
e Driver Software... )
v R E_P'ECUMD& LPT) D'p b\ Locate and install driver software manually.
& B\Ew0 comn isable
=1 Print queues Uninstall
[ Process:
§ Security devices Scan for hardware changes
B Software devices Propertics
i Sound, video and gam itroll
Gu Storage contrall
i

\ @
I e P Sy . B i PP e 00 i By T @ # [ it v Bty - iy i ST W P i LA I kgt VAT

Firom it x e anifaerE o o o o That bt dreer mafaamre for pour dedos moal sy irarisl e
L 1 %t e o W e i W' o A e § T T ] B O e § e P ol i o T B
P ek 1 et P et o
5 L] T s e P B 10 oy B Bk

ey L =

Find the d-'-:-.'l-::.-.- of CPZ1032

o~ o]

|
R A Vil Hap
e w0 EmD = X
[ A PO EPaEd
[ @
== I T
= Dl e
Wl Copley sda ey
o Havim bnlafe Dyven
g 107 ATL TR il
=2 Wi
B rkE g ot poaa ag dedon
STRIEEE
B hriecd wlaann
= R R T
T T T T T
B EWELI T

O Freram

fomrn CO}AB appears in Ports, successfully

e installed.

Ve Users may have a different COM number
which depends on the PC.
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Introduction to slicing software

Introduction of slicing software: @Cura installation, @Machine settings,
®lImport the configuration file , @ Manipulate 3D model in Cura, ®Slice
and preview, ®Print online, @Print offline

1. Cura installation

3D printer reads Gcode file and prints. It is necessary to convert 3D files
(such as stl file) into Gcode files for machine to recognize. Software that
convert 3D files into Gcode files is called slicing software.
Ultimaker_Cura-4.2.1-win64 is used for example here (Users may use
their own slicer software). It is located in memory

card—" Files_English_Mega X"— “ Cura”"— " Windows". Double click

“Ultimaker_Cura-4.2.1-winé4.exe”, and follow the steps as shown

EF Urnrpo Cons Bup - 3 L pdees s S - @
F: Licis g fadualien
Weloome o the Lillimaker Cura Pl it v ot clarE . e el L it Tl
Selup Wizad
Thes il vl Quaths o BWOLQN e il of s Rt Dhowa I 5% The 1ESd o et SEpeseecd
[ § e Lk
lﬁ |L T LTI OEMER A ML LI -~
- i recwrmrmnced el you doss o ot applics oo TR L R
| berbara wherireg Sechup. Thin el mste & poosils b ipdieis
| ~alers wrd pyviern Ban obhg b baang B emeat amr Capaghd (0 501 7 Fres Softes s Rmedete, e onig I o
[ wreem; i1 E il Pt b oo e ehilssis sek o copes
L 3! e decermeri, bud changng § & nod sllooved
| =i R TeET i e e
® Ty mey o e (R Loy 0oyl Pl Licoror: snorpsmeaics
TiE v b ponceiens i e ] e G Geser Publec
o s o Eakereiad by e aldhors perreees e e -
|
| T o B0 2 i O D B o o - T s o M, VI T, ST, M
- ENEEERA] B A | D
—_
—————
e [ o e
U raoer Carp b - = 3 L oy g S =
oo ksl sl Locsason @ Decoe Sl Moy Pl @
Pkl Bk Foded o evtedt b el o Uil Cuii i i o] s Rl Sor o Db G chormods,
Erug wll il ity S i o Tolleaarg Flaed . To resd | 5 dflersnr fodier, dick Rt e B i b Pibdes i ey e sl 608 00 TR The reegrsenan dhod il . s
Ercanta mad s o ihae Pabces . Clck bissd o ot o i WV B RN e b e ol
- -
WO,
JFa
sy
Lh iy
Dicadbragisen Fralier L
=== = gy Profmiegg O3
AR T L | s | | Bafa 71~ B R (e Craeess
B
1.:-:."-3 FaCag
B e el RERE =Lk (T
._ el i, hTub i1

[[lte met peam drenam

e s ] =
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Introduction to slicing software

(3 Ultimaker Cura Setup — * L e g St a0
Choose Components @ ¥ @
Choose which features of Ultimaker Cura you want to instal. EW‘*"II‘I; the: Llitimakes Cura
Selup Wizad
Chedk the components you want to install and uncheck the components you don't want to LI L NG D R O O R e
install. Click Install to start the installation. | B
“ .[ -J 1 Chok Fariak i closa iy mirmed.

Select components to install: Ultimaker Cura Executable and Data Files | |

Install Arduina Drivers |rmanm 1 ey

L[] Install Visual Shudio 2015 Bedistributable guwra -

Open AMF files with Cura L__-'_

Open 3MF files with Cura

Open OBJ files with Cura

Open STL files with Cura I (1L
Space required: 553.6MB Open X30 ﬁleswnh ura I

Open GCODE files with Cura =

< Back Install Cancel -l

Note: Printing online requires the installation of a driver, as shown

below. If you don't print online, you don't need to install it.

HE Wi doees Secueiny
;i Winuld you Bke o irstadl this devios software?
Flarmee: Ackafrud Indeetres LLC Ports (COM &LPT..,

S Pubbshen Sdatrur indistnies
L8

L1

| Alwiys st sofoeasre from * Adsfrui indusinies” Irestald | A

P Youshould orty rwtall drver acthwers From publshen yess drasl, His con | decids
1l whizh deaes acttaam i pere 8o rokai’

2. Machine settings
Upon completion of installation, the first launch of the software will

display the following welcome screen.Click "Get started" to start the

machine settings.

Welcome to Witimaker Cura

e]

Plepse fofoey these sieps in setup
Lithmmer Cura. Tres vl on by cade a hesy mcements
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Introduction to slicing software

User Agreement

@

Disclaimer by Ultimaker
Please read this disclaimer carefully.

Except when otherwise stated in writing, Ultimaker provides any
Ultimaker software or third party software "As is" without
warranty of any kind. The entire risk as to the quality and
performance of Ultimaker software is with you.

Unless required by applicable law or agreed to in writing, in no
event will Ultimaker be liable to you for damages, including any
general, special, incidental, or consequential damages arising out
of the use or inability to use any Ukimaker software or third party
software.

@ What's new in Ultimaker Cura

4.2.0

Orthographic view.

When preparing prints, professional users wanted more control
over the 3D view type, so this version introduces an
orthographic view, which is the same view type used by most
professional CAD software packages. Find the orthographic
view in View > Camera view > Orthographic, and compare the
dimensions of your model to your CAD design with ease.

Object list.

Easily identify corresponding filenames and models with this
new popup list. Click a model in the viewport and its filename
will highlight, or click a filename in the list and the
corresponding model will highlight. The open or hidden state

Decline and close Next
® Help us to improve Ultimaker Cura @ Add a printer
LIRbmyaoe Curd 00 Bedrs an 0wy m o Jaka 10 Impeowe priog quakty
and umer svperience, mouckng Arid p et e prnte -
Thars 3 me printer Eodd seer yonr neivork
Pl o Ey S Maler o s
= AEtresh Al pieaEr by T [Z T - E ST T
Jod 6
, Arld n moo-networked meinie i
N | S |

Muimipis of g0 P ST
. =
i o i Y
el I
I a0 I 1 ~

Data enbecred hy Uitraker Curmwall not contakn any persanal

mformation. g e Eo e ion

Add a printer

®

AN 3 N R pw bt [4

Al 3 non<saren rkgd princs -

= Arpchi

0 Apnuhic dislas

[ Ampoubic Chieon
(¥ Ampoabic il Wega

¥ Mupam Wenture Ca. Lad.

¥ BEEVERWCREATIVE
' ogrp

R 1T

' o

P il

¥ CpCoain CPRALE

Pricvtasr name | Argcobes 3 Aesg

Uitimaker Cloud

®

The rexi generainn 30 prrsmig e il los
-Sand print ohs po Uitinnak or primhars oubs i yhos kocal neteoek
- Shane yode LIEimatezr Curn =eitings in the doud for use sywnese

- 26 e OIS 300RSE [ gt prafies troem faackng hrards

(rEER anamount  Signm
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Introduction to slicing software

According to the wizard, we have selected the "Anycubic i3 Mega"
model. Now, we will set the model parameters of Mega X based on that

model.

(1) Click "Manage printers”, as shown below.

= Utimskcar Curn

Eile Ebt faor Jetbop Eytansiess Freferwsea Hedp

L'.' Anyoshic Mega X

Ansoibiic Kodga
-
(4) Click "rename" to change the machine name to "Anycubic Mega X",
and then click "Machine Settings" .

G Preferences

Ganeral

settings | PriNters

Frinters hotivate Add Rename
Materials

Frofiles

Anycubic i3 Mega

Update Firmware |Machine Settings

(5) Modify the "XYZ" parameters as 304, 304 and 306 respectively on the

"Machine Settings" page, as shown below.

(5 Machine Settings x
Printer Extruder 1

Printer Settings Printhead Settings
X (Width) 304 | «v o] xmin T R—
¥ (Depth) 304 | v mm|| ymin o
i [HE‘lght:l 306 LU i ¥ max [EF) M
Build plate shape Rectan... Y max " -
Origin at center Gantry Height u i
Heated bed o MNumber of Extruders 1 W
G-code flavor Marlin v
Start G-code End G-code

321 metric values Miod 20 ; twn off extruder

Find v Lo TP O o L B T U Lok I, I L =l o Y [ I PR ol n I |
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Introduction to slicing software

3. Import the configuration file

After continuous testing, we provided users the best printing
parameters of different filaments for Mega X, allowing them to directly
import the parameter files from the memory card into the software.

(1) Click “Settings”- "Configure setting visibility...", and then check

"Check all" to make all Settings visible.

E Ultimaker Cura
File Edit View

Extenzionz Freferences Help

Frinter b
Extruder 1 [

Frofile

Configure setting wvizibility .

Setting Visibility

¥ Clack a1 Caston 3al'

Patariale
Frefilax « B faol § iy
& [ Lwanr Ead ghi

(2) Click "profile" on the left, and then click “import” to open the "import
profile" dialog box, then select the "Suggested parameters MEGA X-
PLA- V1.0. curaprofile" (file path: memory card — "File _ English _MEGA
X"), and click "open". After successful import, the following success

prompt will pop up. Please import the "Suggested parameters MEGA X-
TPU- V1.0. curaprofile” file as so.

]

Profiles
AVl & L

2 @

Cwin




Introduction to slicing software

Cura 7 X
C,

o Successfully imported profile Suggested parameters MEGA X—FLA-V1. 0

| 0K

(3) Select the configuration file that you just imported.

|@| [ signi

Click to open — 3| = Normald2mm FH2s% Kl On <= Off #
“Print settings”
Print settings x
= Layer Height o
0.1 0z 03
B4 Infill (%) *
o 20 40 60 80 100
| Gradual infill
L. Support -

=+ Adhesion @
Click to open the print
param?ters interfac}e

Custom 2

,

= Mormal 0.2Zmm B 25% kL On = Off
Print settings @ x
Frojile Mormal w ‘
; High — 0. 1lmm
1 ® Normal — 0. Zmm
Iraft — 0. S3mm

Suggested parameterz MEGA X-FLA-V1. 0

H Create profile from current zettings/overrides. ..

||| Update profile with cwrrent settings/overrides

i Dizcard current changes
Manage Frofiles. .. Ctr]+
4% Cooling <
L. Support ¢
== Build Plate Adhesion ~
Build Plate Adhesion Type & | Skirt hd
Skirt Line Count & |3
Skirt Distance & |5 mm
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Introduction to slicing software

4. Manipulate 3D model in Cura
In the Cura software interface, click on the “File” — “Open File(s)..."” to
import your own three-dimensional format model (such as .stl file).

Users can “Rotate” “Scale” “Mirror” the model. As shown below:

cura

m

L

}
i)

Luls

Other operations:

Per Model Settings: When you open multiple models, you
can configure a separate slice configuration for the
specified model.

[i Support Blocker(E): Set the mask area on the model so that
the support could not be generate on the set area.

After importing the model, users can customize the printing parameters
according to individual needs. But the configuration files that we
provide are suggested.

Note: "Suggested parameters MEGA X-PLA- V1.0. curaprofile file is
prepared for PLA filament, and "Suggested parameters MEGA X-TPU-
V1.0. curaprofile” file is prepared for TPU filament.
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= suggested parameters ME... £5 20% &\ Off = Off » I

Frint settings x
[~

Profile Suggested parameters MEGA X-PLA-V1.0 W

Quality
Shell
Infill
Material

s =21

"-.
>’

Speed
Travel

3% g €

Cooling

Support

Build Plate Adhesion

Build Plate Adhesion Type & | None

£ A A A A A A A A

Dual Extrusion

T
L

Mesh Fixes

=
I

Special Modes

A oma s AL

Experimental

].

Note: The “Build Plate Adhesion Type” parameter needs to be set

to “None” when printing the maximum size modle.

5. Slice and preview

After setting the printing parameters, click the "Slice" button in the
lower right corner of the software. After the Slice is finished, click the
"preview" button to preview the simulated printing effect in the preview

view.

() 9 hours 48 minutes (i )

Previ... Save to File
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Introduction to slicing software

Click to preview the
simulated printing effect
. -in the preview view

6. Print online
After the parameters have been set up, you can print online via Cura.
Click the "MONITOR" button on the main interface. If the printer is not

connected properly, the interface will be blank.

After connecting the data line, Cura will automatically connect to the
printer. After waiting for more than ten seconds, the operation panel
will be displayed on the right side of the interface. User can control
printer through the operation panel. (In the process of printing, do not

plug the data line, or it will interrupt the printing)
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v BCNTTOR

hnyrubic Mega ¥
3L
Frufimai

A1

Prosdaai

7. Print offline

After slicing, click "save to file" in the lower right corner of Cura
software. Save the model GCode file to the memory card, and then
insert the memory card to the printer and control via the touch screen
for offline printing.

Note: the file name should only contain English letters, underscore and
space. File name contains special characters could not be recognized
by the printer. In order to let the printer better recognize the Gcode file
in the memory card, you need to back up all the files in the memory
card to the computer, and keep the memory card only for the Gcode file,

please save all the Gcode files in root directory of the memory card.

(© 9 hours 48 minutes (i )
Il 67 - 22.39m

Save to File
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Printing

Here shows the steps of printing offline (via memory card).
1. Plug in the power cord and power on the printer.

Click “Tools” — “Preheat” — “Preheat PLA" (for example).

2. After the pre-heat s finished, please click on Home screen
“Tools"—"Filament” —"Filament in”. The extruder motor will start to
feed the filament into the hotend. There might be some excessive
filament melt through the nozzle at high temperature, use tweezers to
carefully remove it from the nozzle tip before print.

3. Insert the memory card into the memory card slot at the base. On
Home Menu, Click “Print” to enter the files list. Click a exist file (e.qg.
“owl_pair”), and click “Print”. The machine will be sequentially heating

the heated bed and nozzle and then print.

S u Raaam ©

owl pairgoode

3

FRINT RESUME
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Printing

4. Upon finishing, the print head and heated bed will be automatically
cooling down. Only remove the printed object from the heated bed
when it is cooled completely. Pull the print platform to the front side,
and use spatula to carefully remove the object. Never direct scarper to
your hands.

Please be mindful that the nozzle and heated bed are still hot after

operation.

5. Mega X 3D printer equipped with ANYCURIC ultrabase(a novel print
platform) which could be used for very long time without adding any
masking tape, “hair spray” or glue stick. Customers only have to clean it
by alcohol or similar after every few prints.

Suggested nozzle (print) temperature for PLA: 190-210 °C, ABS: 230-
240 °C, Bed temperature for PLA: 60 °C, ABS: 90 °C. (it is suggested
to disable the model cooling fan for ABS in Advanced settings of
Cura)

After operation, do not immediately switch off the printer. Only turn it
off after the nozzle cools to room temperature, because the heat sink

still needs fan for cooling to minimize the risk of nozzle clogging.
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Introduction to filament sensor

1. Mega X alarms when filament break during an ongoing print, the
interface shown below will be popped up.

Lack of filament or filament
manitar abnonmal

2. Click “OK", remove the remaining filaments and re-installing new
filaments. Remove the remaining filaments: pull out the teflon feeding
tube, then press the handle on the extruder and firstly push the
filament in till the filament is just melted through the nozzle, then pull it
out quickly.

Re-install new filaments: see page 19 “Filamentin”.

3. After the filaments re-installed, use tweezers to clean the filament
residue on nozzle tip. Then click “CONTINUE", the print will start again

from the last position.

CONTINLIE,

37



Resume from outage

Mega X allows resume print after accidently power outage (This
function only valid when print offline, via memory card only).

1. As shown in Fig.(1)(2) , in slicing software (i.e. Cura), it is required to
place the model at the rear of the platform. Because during “RESUME",
machine will home first and could touch/interfere with the unfinished

object if the model was placed in the front area.

Rear area
[ = e
] e !
| J{J :'1 1
l Ca—— |
¥
1 e 1"}_' :
I | I
| i 1

Zero (Home position)

(1) (2)

2. For the first time of using this function, users are required to add “G5”
to the start.gcode, as shown in Fig. (3). Then, save the model as GCode

file to the memory card.

Ty ol '
nitan | Printers
Adrinin & N B e e © -] ]
Wabarils ;
T ey ANyCusbic Mega X
= Plaschin e Setvienyy W
Frrawi Lamiaier 4
Frirdes Sefinga #r v e Sattinegs
=% N XiTen
7 T an i
FHAR - % s
Bidld plos ek 3ge Ehozrar
01l 1 O e CAFlip HRLRL
Heaim bl o Phamiias f Fal Fiacis
G-vod e P Bl o i
Sap

| 6 E g _trwal) LTI T S R e DT

T Add YGE
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Resume from outage

Note: @ “Resume from outage” is valid only for offline printing;
@ Just type the “G5” when you use it for the first time, G5 will be

automatically added later, without having to manually type it again.

3. During printing, if there is an accident power loss, the print will stop
immediately. But after power comes back, customers could choose
“Print” — select the unfinished file— “RESUME", machine will home first

and continuing on the unfinished object.

" w Foafu

P
b
Irl—‘
'J,r’

PRINT RESUME

Note:

(D In order to get smooth surface, use tweezers to carefully remove the
excessive filament at nozzle before continuing print upon the last point.
@ Do not move Z axis after power off otherwise resume will be invalid.
(3 Mega X supports resume from outage only when print offline

@ This function is developed based on Cura. We could not guarantee
this function compatible with other slicing software.

®) Due to the differences of models, filaments, temperature, extrusion
settings, etc...we could not always guarantee a perfect surface finish at

the point of “"RESUME", especially for small objects.
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Maintenance

It is necessary to perform routine maintenance to the 3D printer to

achieve consistent and quality results.
Some maintenance suggestions are shown as below:

1. Clean the nozzle with the nozzle cleaning needle under preheating
conditions. If the filament residual in the nozzle could not be cleared

100%, please replace the nozzle.

2. Regularly add lubricating oil to smooth rods, flanged bearings, lead
screws, brass nuts, etc. By doing so, it can minimize the wear-out

failure of those moving parts.

3. Regularly clean the filament residuals and dirt on the nozzle,

platform, guide rail, motor, fan, etc.

4. Pay attention to the wear conditions of the D-shape wheels. They
could be used for long time, but please replace the D-shape wheels if
they have been wore-out. Besides, you need to adjust the tightness of

the D-shape wheels by referring to page 9 when they are idling.

5. After finishing a print, clean the heated bed to ensure the adhesion

of the bottom layer of the model for next print.

6. Check the belts regularly and tighten them if necessary.



Troubleshooting

1. Motor shaking or abnormal sound

(D The corresponding end stop could not be triggered when Home,
check the wirings, and inspect any obstacles by manually moving the
corresponding axis.

@ The motor cable are not connected properly, check each connection
and then inspect the cable routing for any faults.

® The motor is damaged.

2. File not printing or memory card failure

(D Remove the memory card and insert into PC. Open the GCode files
using text editor (eg. Notepad), and inspect if GCode is readable or not.
If files contains of multiple “yyy” symbol, then file has been corrupted.
Try reformatting the memory card to FAT32 format and reloading the
GCode file

2 Memory card is not readable, ensure file name does not contain
special characters or Change memory card

3 Touch screen freeze, reboot the machine and try again

3. The temperature of the nozzle gradually drops after clicking print
(D The printing process is a process of executing the print file one by
one command. The command to start printing is usually to heat the
heated bed, heat the nozzle, home, etc.. It need to wait for the heated
bed command to execute before executing the heated nozzle

command.

4. No extrusion or extrusion motor knocking

(D Ensure that the nozzle temperature has been set to match the
filament

@ Filament tangled on spool

3 Not enough cooling for the hotend
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Troubleshooting

@ Nozzle clogged please try to replace it or clean it with the nozzle
cleaning needles

® Teflon tubing has been tangled, squeezed or bent

5. Filament leaking
Nozzle or throat tube is not tightened properly, try to fix/change it after

cooling

6. Warping/curling of the printed object

(D Check the bed temperature matches the filament

2 Check the infill % of the GCode. The higher the infill, the more likely
to warp

3 Add a brim or raft to the model in slicing software.

7. Layer shifting

@ Print head moving too fast, slow down the print speed.

(2 Check X/Y belt and the driving wheel and ensure they are properly
installed.

(3 Grease the rods and check all nuts and bolts remain tightened.

8. No sticking to the bed

(@ Print too fast at the bottom layer speed, reduce it to ~20mm/s
(2 Ensure that the print platform is clean (use alcohol if necessary)
® Check if the bed is proper leveled

@ Add a brim or raft to the model in slicing software

® Check the bed temperature matches the filament

9. Freezing screen

@ Inspect if the touch screen has been pressed by the metal frame at
the edge

@ Check if screen has cracks, if so, please contact us at

WWW.anycubic.com
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Troubleshooting

10. TO sensor abnormal
(D Check the wiring of the hotend and ensure a good connection

@ Check if there is any pins bent inside the connector

11. Print head move abnormal
(D Check if choosing the right machine type in slicing software

@ Check if any plugins in the slicing software

12. Print stopped halfway

(D Check if the GCode file is corrupted.

2 Delete plugins in the GCode file.

3 Use print offline mode (memory card) instead of print online via data

cable.

13. The print model is too large to be removed from the platform
(O Preheat the platform and then shovel it with a spatula.

14. The model looks normal but some parts cannot be printed

(D Special parts such as overhanging part need to be added with
support, etc., and need to be adjusted according to the specific model.
It is recommended to preview the print layer to see if it meets the
requirements.

15. Drawing is more serious

(D The retraction distance is insufficient. It should be set larger when
slicing.

2 The retraction speed is too slow. It should be set a bit faster when
slicing.

(3 The printing temperature is too high, which causes the fluidity and
viscosity of the filament to be strong. The printing temperature need to

be set lowered a little.
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Thank you for purchasing aNrc¢uRi¢ products! Under normal usage and
service, the products and its parts have a warranty period up to one

year. Please visit ANvcueic official website (www.anycubic.com) for

more details and report any issues with ANvGURIC products. Our
professional after-sale service team would response within 24 hours

and help you to solve the issue.


http://www.anycubic3d.com/
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